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ABSTRACT 

In the current study, we aim to investigate the use of Google Earth and Google 
Maps Applications on tablet and laptop computers. The research was carried out 
during the Geography Club seminars organized at “Radu Petrescu” High School in 
the 2013-2014 school year. The research involved 13 students in various 
gymnasium and high school grades. The activities included: navigation with Google 
Earth/Maps, image capturing techniques, virtual tours, measuring distances or river 
lengths, identifying relief forms, and locating geographical components of the 
environment. In order to retrieve students’ opinions regarding the use of tablets 
and laptop computers with these two applications, they were asked to respond to a 
questionnaire after the activities took place. Conclusions revealed that students 
enjoyed using these applications with laptops and tablets and that the learning 
process during Geography classes became more interesting. 

Keywords: virtual tour, e-learning, Geography Club seminar, electronic portfolio, 
virtual lesson 

INTRODUCTION 

Following Romania’s admission into the European Union, Art. 68 of the Law 
on National Education (2011) in Romania specifies the key competences 
that any student should display as he or she undergoes mandatory 
education cycles. “The national curriculum for primary and secondary 
education emphasizes 8 key-competence domains which determine the 
profile and formation of any student.” Two of these domains are: “basic 
mathematical, science and technology skills” and “digital skills in the use of 
information technology as a learning and knowledge tool”. Two main 
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reasons justifying the creation of these competences are the following: 
“education and professional development of children, young adults and 
adults aim at developing skills as a multifunctional and transferable 
assembly of knowledge, skills, abilities that are necessary for personal 
development and fulfilment, social integration and active societal 
participation” (2011, Art. 4). 

There are also relevant studies about the use and advantages of tablets 
and laptops in education (Smith, Valliappa, 2006; Whitmeyer, 2012; Fabian, 
Maclean, 2014), about the role of digital literacy (Hall, Atkins, Fraser, 2014) 
and of geographical literacy (Thomas-Brown, 2011; Chou, Block, Jesness, 
2012) in achieving the objectives of geographical education, as well as more 
focused studies on Google Earth as a resource (Lisle, 2006) and as more than 
a Geography education tool (Patterson, 2007) and its usefulness in interpreting 
geographical phenomena, alongside satellite imagery (Sato, Harp, 2009), and 
in landscape visualisation (Sheppard, Cizek, 2009). 

The concept of digital competence is being used with increased 
frequency nowadays: “Given the complexity of this area and the critical 
importance of the practices involved, it is unsurprising that we find a large 
number of competing frameworks for describing literacy of the digital age. 
They have been developed to meet different purposes, out of different 
theoretical and political perspectives, and use a wide range of terminologies 
from systems thinking to social science and critical theory” (Beetham, 
McGill, Littlejohn, 2009, p. 27).  

Teachers, pupils and students in Romania now display active interest 
in using devices such as tablets or laptops owing to their small size and 
increased storage capacity for information that would occupy large space in 
printed format. Thus, these computational devices allow visualisation and 
editing of any type of documents, storage and display of Geography content 
via multimedia, internet access, including via Geography applications, social 
networking, and Geography dedicated forums. Therefore, “tablet PCs can 
also help with adapting instruction and inviting participation. Today’s 
classrooms are becoming fully wireless, which lets teachers harvest and 
aggregate students’ contributions” (Roschelle et al., 2007, p. 39). 

The current research aims to investigate the usefulness of tablets and 
laptops from the perspective of students, starting from the premise that the 
Ministry of Education and Scientific Research in Romania has manifested the 
desire to introduce tablets as educational support starting with the 
preparatory grade in view of gradually replacing printed textbooks: 
“Romania is at the forefront of countries that are adapting their educational 
systems to the worldwide trend of using information technology in the 
teaching and learning process” declared the Minister of National Education 
and Scientific Research, Remus Pricopie, with the specification that this 
tendency was confirmed by the new Horizon Report of the European 
Commission, in partnership with educational technologies experts in the 
USA (Gheorghiţă, 2014). 
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In the Romanian educational system there is the perception that the 
use of applications on tablets and laptops automatically leads to the 
improvement in the quality of the educational process and to an increased 
interdisciplinary connection between information acquired during learning. 
This research also aims to identify the main advantages of replacing 
classical learning aids with internet connected tablets.  

Romanian Geography teachers, pupils and students have Google Earth 
and Google Maps applications at their disposal. In this study, we shall also 
analyse the use of Google Earth and Google Maps during Geography classes as 
“Google Earth lets you fly anywhere to view satellite imagery, maps, terrain, 
3D buildings, galaxies in outer space, and the depths of the ocean”1; “Google 
Maps for Education provides resources to help teachers and students explore, 
create, and collaborate with mapping tools. Students who are taught 
Geography are better equipped to understand how human and physical 
systems interact and to make informed decisions based on that knowledge2.” 

Google Earth can be defined as a browser or a free interactive 
geographical tool that enables one to travel to geographical horizons 
directly from one’s PC, tablet or Smartphone with the help of satellite 
imagery. Operators can see maps, terrain, buildings in three-dimensional 
format, explore galaxies, planets and ocean depths with the help of this 
imagery3. Thus, images from all over the world are available to anyone who 
owns a device with an internet connection. The program offers a range of 
available functions such as visualizing locations, traffic indications, distance 
measurement, and air flight4. Google Maps is an online service specialized in 
visualizing satellite images of the Earth surface and it displays search 
functions, orientation tips, 3D visualization, and a “Street View” function 
allowing ground-level visits of particular locations5.  

    

 

METHOD 

 

Participants. The research involved 13 students in various gymnasium and 
high school grades from “Radu Petrescu” High School in Prundu Bîrgăului, 
attending the Geography Club seminar. The group included 3 pupils from the 
5th grade, 2 pupils from the 6th grade, 3 pupils from the 7th grade, 1 pupil from 
the 8th grade, 3 pupils from the 9th grade and 1 pupil from the 10th grade. 

                                                            

1 https://plus.google.com/u/0/+GoogleEarth/posts 
2 http://maps.google.com/help/maps/education/ 
3 https://www.google.com/intl/ro/earth/ 
4 https://www.google.com/earth/outreach/tutorials/index.html 
5 https://support.google.com/maps/answer/144349?hl=ro&ref_topic=3092425 
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Procedure. The research unfolded during the 1st semester of the 
2013-2014 school year. The activities took place in the projection hall of the 
Centre for Information and Research, students being positioned facing the 
image on display, output from a laptop to a video distribution amplifier.  

Operating systems. During the teaching activities we used laptop, 
tablet and Smartphone operating systems such as Android, Apple or 
Windows 7. Most frequently, the students’ tablets employed the Android 
operating system. On the laptop computers, Windows 7 and Windows 8 
operating systems were used.   

 

The experimental teaching activity unfolded in the following stages: 

1. Introducing the Google Earth and Google Maps applications. During 
the first meetings, we presented the installation of operating systems used 
on the students’ laptops or tablets and the navigation procedures. Students 
turned the devices on and accessed an internet browser in order to install 
Google Earth or Google Maps applications.  

2. Instruction regarding geographical spaces. We explained to 
students what the navigation options were, the significance of each element 
in the application menu and their usage (Fig. 1). Navigation options were to 
be found on the right side of the program window, the functions of the 
program were aligned in the menu bar on the upper side of the window, and 
on the left one might notice the layers of the program where usage and 
visualization options could be selected.  

 

 
Fig. 1. Explaining the main functions of the Google Earth application (screenshot) 

 

3. Image capturing techniques. Virtual tours. Students learned how 
to capture geographical images by means of two methods: firstly by saving 
images with the File menu, secondly by pressing the Save image button on 
the menu bar, then saving the images as folders for later retrieval and use 
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for projects, presentations and others. Students also learned about the 
Virtual tour option by selecting Take a tour on the menu bar which played 
recordings of navigations above the area of interest in order to display a 
virtual tour similar to a film or a video (Fig. 2).  

 

 
Fig. 2. Explanations on how to take a tour of the Grand Canyon (screenshot) 
 

4. Piloting a virtual tour. With the help of Google Earth, students 
simulated flights above the Earth’s surface by selecting the Flight simulator 
function from the Tools menu. Thus, they had the opportunity to choose 
between two types of airplanes and carry out virtual flights above particular 
areas on the globe, as chosen by each student. 

5. Making maps. The teacher explained to students how to create 
climate maps, demographic maps and other types of maps.   

6. Measuring distances, mountain paths and rivers6. The teacher 
explained how to measure the distance between cities and localities, terrain 
distance between selected points on various tracks that students had actually 
trekked in the past, the distance between river origin and river influx. 

7. Locating geographical oddities. Students looked up the list of places on 
the Earth where interesting geographical phenomena or processes occurred. 
Students were assigned the task of locating these places and of creating a 
virtual tour above the selected area. Location was found by inputting the name 
of the location or the geographical coordinates in the entry box.  

8. Capturing images of natural and man-made disasters. Students 
accessed internet pages containing information and statistical data about 
natural and man-made disasters7, and then they located the respective 

                                                            

6 https://support.google.com/earth/answer/148072?hl=ro&ref_topic=4386089 
7 http://earthobservatory.nasa.gov/NaturalHazards/ 
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areas via Google Earth and Google Maps. They analysed the images and 
conceived theories concerning the causes of calamities or of disasters based 
on the images they had analysed.  

9. Storing projects in an email address. The images that were 
captured were sorted in folders, with the names of activities and then 
uploaded in an email address.  

 

Data collection and analysis  

In order to analyse the usefulness of Google Earth/Maps applications on 
tablets and laptops during the Geography Club seminars and during Geography 
classes, we assigned a questionnaire containing 10 questions to the 13 students 
attending the seminar. For each question, students could choose one answer of 
the 4 formulated: useless, useful, very useful, I don’t know/I don’t answer. 
Beside the four possible answers, students were given the opportunity to 
provide arguments for the answers they had provided to each question in a few 
words. We also analysed the manner in which students carried out their 
assigned tasks as well as each student’s electronic portfolio(s). 
 

 

RESULTS  
 

In figure 3, we represented the answers provided by our students for the 
questions in the questionnaire: 
 

 
Fig. 3. Students’ answers to the questionnaire 
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In figure 4, we represented the usefulness of Google Earth and 
Google Maps applications in the study of Geography, from our students’ 
perspective.  

  

 
Fig. 4. Usefulness of Google Earth and Google Maps applications in the 

study of Geography, from students’ perspective 
 

 

DISCUSSIONS 

 

Analysis of questionnaire answers  

Question 1: “What do you think about the use of tablets/laptops in 
accessing Google Earth/Maps applications during Geography classes?” 54% 
of the students believed laptops and tablets were very useful, 46% 
considered them useful, and none of the students considered tablets and 
laptops useless. All students answered this question. Some of the 
arguments contained remarkable responses such as: “It is modern and 
revolutionary”; “Finally, we see something appropriate for our generation”. 
The fact that all students considered the devices and applications very 
useful and useful during Geography classes indicated their interest in 
modern technology and interest in learning new things.  

Question 2: “How useful are the Google Earth/Maps applications 
during Geography classes and during Geography Club seminar?” 77% of the 
students responded very useful, 23% responded useful, and there were no 
students who responded useless or I don’t know/I don’t answer. Three 
students commented their options: “It is much easier to search locations 
with Google Earth as compared to the old map”; “With Google Earth, 
through the option to visualise via webcam, we were able to see what 
activities people were doing right at that moment”; “We can better 
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understand the meaning of some notions, such as inselberg, moraine, or 
what volcanoes or icebergs look like.” 

Question 3: “What is your opinion about replacing paper handwriting 
with the handwriting function on tablets or on other devices?” 54% of the 
students considered this function very useful, 38% of the students 
considered it useful for replacing paper handwriting, and 8% of the students 
considered it as being useless. Among their arguments, they mentioned: “I 
can write with ease on the tablet by using this function”; “Storage space on 
the tablet is considerably larger than on a classical notebook”; “We didn’t 
need to buy notebooks or writing tools”. The fact that 92% of the students 
appreciated the usefulness of handwriting on tablets is due to the 
simplification of the writing, deleting or colour choice procedures.  

Question 4: “What is your opinion about replacing classical lessons in 
Geography text books with virtual lessons using Google Earth?” 62% of the 
students considered this very useful, 23% of the students considered it 
useful, and 15% of the students did not answer this question. Students 
supported their views: “Quick retrieval of information”, “quick localization of 
geographical elements”. There were no students to consider the virtual 
lessons useless. The fact that some students did not respond was, we 
believe, because they did not fully understand the differences between the 
two types of lesson structure. 

Question 5: “What is your opinion about the possibility to take virtual 
tours anywhere in the world with Google Earth?” 62% of the students 
considered it very useful, 31% deemed it useful and 8% opted for the 
response I don’t know/I don’t answer, but no student considered it to be 
useless. Among those who appreciated virtual tours to be very useful, two 
students argued: “Thus we can make films and videos”; “It would be easier 
for me to watch a virtual tour of Niagara Falls than to read about it and not 
know what it looks like”. We thus discovered that with .kmz/.kml files, one 
can memorize more quickly the details regarding the aspect of some forms 
of relief, the size of mountains or of other areas. 

Question 6: “How useful is the teacher’s experience in Google 
Earth/Maps applications during Geography class activities? 54% of the 
students considered the teacher’s experience with the applications to be 
very useful, 23% deemed it useful, 15% chose not to respond to this 
question, and only 8% considered teacher’s experience to be useless. One 
student mentioned that: “The teacher’s experience in knowing these 
applications is important for us because the teacher must explain some 
things about every area in which we travel with Google Earth.” 

Question 7: “How useful are tablets or laptops for the activities 
unfolding during the Geography Club seminars and during Geography 
classes when Google Earth/Maps are being used?” 54% of the students 
considered them very useful, 38% responded useful, 8% of the students did 
not respond, and no student responded useless. Some students made the 
following comments: “The tablet and laptop replace the schoolbag and a lot 
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of books”; “It is extremely useful because it is the best and the quickest 
way to search information in case we need it”. 

Question 8: “How useful are Google Earth/Maps applications in the 
process of learning and memorizing?” 54% of the students opted for useful, 
38% of the students considered them very useful, 8% chose the option I 
don’t know/I don’t answer, and no students opted for the answer useless. 
One student specified: “With Google Maps, I can memorize the places much 
better than with the old map.” Students preferred activities that included 
virtual learning based on the visualization of static or dynamic images 
because they facilitated understanding processes and aspects of the Earth’s 
surface and memorised places much quicker as compared to understanding 
and memorising descriptions presented in texts.   

Question 9: “By using Google Earth/Maps applications, we can reduce 
paper consumption in schools. What is your opinion about that?” 69% 
appreciated this aspect as very useful, 23% believed this to be useful, 8% 
of the students opted for useless, and no students responded I don’t know/I 
don’t answer. Students made reference to environmental protection by 
reducing paper consumption and implicitly deforestation: “The paper used 
for textbooks and school materials can gradually be replaced by virtual 
materials”; “Wood consumption will decrease”. Responses to this question 
proved our students’ preoccupation for environmental protection, a positive 
feature of virtual education.   

Question 10: “Which of the activities carried out with Google 
Earth/Maps during the Geography Club seminar did you find to be the most 
interesting?” 46% of the students appreciated virtual flights to be the most 
interesting, 23% were interested in locating geographical oddities, 16% 
were most interested in measuring the Nile and Amazon rivers, and 15% 
preferred the activity natural and man-made disasters. 

Virtual airplane flights over desert or mountain areas all over the 
globe were preferred by 46% of the students because they used some 
commands that were similar to some computer games. The places in which 
odd phenomena or processes occurred and could be visualised with the help 
of satellite imagery aroused great interest and the images were analysed by 
all our students. As regards natural disasters, students visualised areas in 
which tidal waves (tsunamis), earthquakes, volcanoes, and landslides 
occurred. With Google Maps they captured images, assigning each image to 
a link, then saved and stored the images on an email address.  

 

Analysis of the learning process and of students’ results  

Following the activities, we evaluated students’ electronic portfolios. 
They presented their electronic portfolios in folder format. In each portfolio, 
every student saved images, files, .kmz/.kml with virtual tours for each of 
the activities carried out during the Geography Club seminar, personal 
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climate maps, individually designed for particular areas on the globe, length 
measurements, and forms of relief, images captured via Google Earth or 
web links to images captured via Google Maps. 

In making video materials, students used .kmz/.kml type files, which, 
according to Google, were defined as “KML, or Keyhole Markup Language. 
This is an XML file type used for modelling and saving Geographical 
functions such as points, lines, polygons and models to be displayed in 
Google Earth, Google Maps And other applications.”8 Once they were saved, 
these files directed the operator to a virtual tour around Google Earth. 
Students practiced the use of the applications by creating these files and 
then by posting them in a Google database. In the following section, we 
analysed some of our students’ creations. 

In Figure 5, we see the journey of a student piloting an airplane. 
While on this journey, the student observed the forms of relief, the 
vegetation, the rivers, and the glaciers. We believe that the student needs 
the explanations of the teacher in order to understand what he/she sees 
while using this application. For the teacher, it is easier to provide 
explanations while all students are travelling on the same tour. If every 
student travels to individual places, it might be impossible for the teacher to 
provide the necessary explanations simultaneously for them to understand 
the visualised scenery. 

  

 
Fig. 5. Piloting an airplane to Mount Everest by a 5th grade student  

(Google Earth screenshot) 
 

In creating climate maps, our students read a list of types of climate 
on the globe and the category/place in which each type fitted, and next 
they set up colours for each climate area. In assigning colours to some 

                                                            

8 https://support.google.com/earth/answer/148118?hl=ro 
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climate regions with Google Earth, they accessed the Add menu, where they 
selected the Polygon action, then they drew a contour around the respective 
region9. As can be seen in Figure 6, the student assigned the colour red to 
the tropical climate, pink to the sub-tropical climate, and brown to the 
mountain climate of the Andes. With this application and by solving this 
task, students learnt new methods of representation for geographical 
phenomena and they got a better understanding of their spatial distribution.  

 

 
Fig. 6. The climate map of South America made by a 7th grade student 

(Google Earth screenshot) 

 

In measuring the length of the Amazon River (Figure 7), students 
consulted various resources about the river10 on the internet. In order to 
measure the length of the river, they placed the cursor on the image of the 
river source in the region of Mount Nevado Mismi (Peru), then they selected 
the option Path in the Add menu, at which point the cursor changed shape 
into an arrow that drew a continuous line on the river stream all the way to 
the influx. Measuring river lengths on the globe aroused great interest at 
the beginning of the activity, after which students lost interest because this 
task required repetitive, monotonous actions. 

 

                                                            

9 https://support.google.com/earth/answer/148072?topic=2376756 
10 http://ro.wikipedia.org/wiki/Nevado_Mismi 
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Fig. 7. Measuring the length of the Amazon river stream by a 9th grade 

student (Google Earth screenshot) 
 

In Figure 8, we notice a student selected Ayers Rock with Google 
Earth, thus manifesting curiosity about this location. If every other student 
selects another interesting place on the globe and searches information 
about it, we have to wonder whether students profoundly understand the 
formation of that place, the geographical processes taking place, the 
consequences and relations between environmental components. 

 

 
Fig. 8. Ayers Rock, located with Google Earth by an 11th grade student (screenshot) 
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In Figure 9, we see a student selected Mount Vesuvius using Google 
Maps. He performed a rotation of the image and analysed the region to get 
an idea of what might happen in the case of a new volcanic eruption. The 
student was able to observe and analyse the volcano cone, crater and 
products of volcanic activity.  

 

 
Fig. 9. Mount Vesuvius (Google Maps screenshot) 

 

Despite an obvious increase in technology use to the detriment of 
traditional teaching tools, by using laptops and tablets, teachers and 
students alike are faced with challenges that we coped with in this activity 
ourselves: lack of familiarity with the applications used on tablets; lack of 
knowledge about options within the operating systems, complexity of 
commands, internet connection malfunctions. Additionally, constant 
changes within the software create operating problems both for teachers as 
well as for students. 

Because of faulty internet connection, image clarity was low and 
additional time was required to retrieve images at high resolution. In order 
to remedy the situation, the best solution was often to restart devices and 
apply commands at a slower pace in order to have enough time to run the 
programs. 

In some cases, the activity was disrupted when every student had to 
navigate Google Earth to locate an image of natural disasters or of 
geographical oddities, in which case the single wireless connection source 
displayed difficulty in handling a large number of users. During the virtual 
tours activity or during the airplane flight activity, students required more 
time to perform the tasks on account of some slow processor devices. 
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CONCLUSIONS 

 

This research led to a number of conclusions: 

Students preferred to use laptop or tablet devices to process 
information for a number of different reasons: they were easy to carry 
around and occupied less space; they could get information more quickly as 
compared to printed sources; they could retrieve and re-access information 
with ease; they could easily store large volumes of data. 

Our students displayed great availability in learning how to use 
Google Earth and Google Maps applications. They were receptive to the 
indications provided, manifested curiosity and interest in learning new 
things, became responsibly involved in the tasks and demonstrated ability 
in successfully accomplishing tasks by using laptop and tablet devices.  

The use of the two applications was appreciated by students because 
they reached the conclusion that they could get a better understanding of 
the phenomena and processes occurring on the Earth’s surface, that they 
were forming more accurate representations as compared to simply reading 
about those phenomena, that they were memorising information more 
easily and they retained more data if they associated images and performed 
practical applications as well. 

As far as the operating systems employed in the activity were 
concerned, the most efficient proved to be Android for tablets and Windows for 
laptops. The technical difficulties that our students faced did not have a 
negative impact on the overall development of activities. These technical 
difficulties could be remedied or simply avoided by minimal organizational 
changes or by resorting to a more recent software version. Protection against 
information loss was ensured with the Cloud function on each device. 

From a financial point of view, the advantages were extensive as the 
cost of tablet devices were much smaller than the cost of consumable 
traditional materials used by students for the full length of their educational 
cycles (four years in secondary school, four years in high school). To ensure 
the financial support needed to provide the devices necessary for a class 
activity or for Geography Club seminars, there is the possibility of accessing 
various financing projects.  
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